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13 ESRSEMENEERN

EEEME T4 BIE%S - WEEE (Waste Electrical
and Electronic Equipment)

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please
visit www.philips.com/about/sustainability/recycling.



http://www.philips.com/about/sustainability/recycling
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Main menu

— Input

— Picture

— Audio

— Color

[ Language

{— OSD Setings

L sewp

Sub menu
E HDMI
Picture Format —  Wide Screen 43
Brighness  — 0~100
Conrast ~ — 0~100
SmartResponse — OFf, Fast, Faster, Fastest
SmartContrast — On, Off
Gmma  — 18,20,22,2426
Pixel Orbiing — On, Off
OverSan  — On, OFf
Sand-Alone  — On, Off
[ Mute — on.off
Color Temp.  — 6500K, 9300K
E sRGB

Red: 0~100
User Define E Green: 0~100
Green: 0~100

— English, Espaiol, Franas, Deutsch, lalano,

Portugués, Pycckuit, F]T#[1¥ , Tiirkge
[ Horizonal ~ — 0~100
{— Vertial — 0~100
{— Transparency — Of,1,2,3,4
L 08D Time out — 5.10,20,30, 60
— Auo
— H. Position — 0~100
[— V. Position — 0100
{— Phase — 0100
[ Clock — 0100
{— Resolution Notification — On, Off
[— Reset — Yes.No
L Information
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SmartControl Lite PHILIPS
Help
Brightness
Improperly adjusted Brightness wil result in a loss of
e ke mage arev. et the Brgheness o
the best possible picture quaity.
Lowerthe Brightness o the mnmum vel
R the Brightmass v the destad e
A the Bightness 35 hesded to chve =

an equal separation of the stripes.
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Color

.
ol

\ Focus Brightness 100
* - .

undo Reset.
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Options ?
L "
Resolution Brightness
Help CO0f A
‘ Focus
P
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Options ?
o
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B8 smartControl 2- Philps 22581 (C530715000001) {2 \ﬁ
. Help
SmartControl Lite PHILIPS
Contrast
Adjust the Contrast (use the sider) to keep details in
s the Contrast und the numbers 1 and 2 C
are 10 longer veole
2. Slowly lower Contrast to make the
numaers 2 and 3 resppear. The numoer .
houk remai barcly vebk. SmartControl Lite
Adijust
sghness
@ Contrast.
Color S/‘f:
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F
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Options y Undo Reset
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Color ~n
A
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PHILIPS

Focus

Your display's timing needs to be synchronzed with
the video signal

1. Choose Auto Setup.

2. Ifthe vertical bands are stil visble, you'll need

to adjust the Pitch.

1y to make the vertical bar
\ase: Adust to the brghtest se
movement on the screen.

pitch:

pitch

g

Phase

Undo Auto Setup

2- Philps 22581 (€530715000001) {2},

PHILIPS

Position

Use the Position buttons to center
your display. Using this tool, you can post
up, down, left, or right.

image on
he image

1. Use the Up/Down buttons to center the mage

vertical.
Use the Left/Right buttons to center the image
horzontaly.

undo Reset.

2 phips 22581 (cS30715000001) (Z]X
PHILIPS

Resolution

You are currently at a Preferred resolution. For your
display to show crsp, clear text, colors, and images,
your display should be set to its Preferred resoluton.

I your display i at 2 Non-Preferred resolution, cick
on the Preferred button to change your resoluton to
Preferred.

I™ Enable Resolution Notifer

Picture Format.
I™ 413 aspect ratio

Preferred
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White Point
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1. Please select White Point value for the best
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Black Level
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!
undo Reset
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Display Gamma

]
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2

Color Disphay Gamma

A
\[g Diplay Gamma Smartimage Off
-l
Options Calibration ot et
&p

Smartimage

®

Help

1 Smantcontor 2 Phaps 22581 (CS30/15000001)  {L£1\%

SmartControl Lite PHILIPS

Calibration

1

Adiust Ree
H
Color White Point Protected by U.S. Patent No. 6,686,953
\ Disply Gamma
Lalels Calbration
N ap
Smartimage
Help
Show e start
Quick View

MShow Me; (3EH) BIABEREFZRIE
HERIE -
Start (FHLR) - FEtA 6 TRBMNEERIEIRE
J_‘%_ °
Quick View ( JRRER ) FEA LB Z
Tﬁﬂ’]?&%
IR ([E] Color (% ) EEHE
Cancel (BUH ) 12t -
Enable color cahbraﬂon ( BABNRIE) -
ﬂ:tljj HRERRK - BEEUBAE  BEE
ﬁ@“”BCIE ﬁ’ﬁﬂ start (B3R ) F quick
view (RIERIRAR ) IR 2EERE -
RESA—EEHIREFNER -

BE—T



F—EEERESN

- HRE_EEFEECH  g=A
Previous ( _E—1{@ ) #%4f -

« Next(T—{@) AFEAT—EER (£B
6 BEE) -

*  Final (518 ) AJ#EEE A File > Presets (15
%> TERME ) Big -

«  Cancel (BUE ) AIBERAFERE N HENR[E]
SMNEENEM ©

Smartlmage Lite

AREEREREAS  HREEE LRI
BRRRE °

% E Entertainment (1242 ) BF > B Smart
Contrast 1 Smart Response ©

8 smartcontol 2

SmartControl Lite PHILIPS

u n

Adjust Rea

=
(]

Color \'.mta'Pmm:
e 4
=
Options Calibration
@7
£ )
Help
©

Internet Standard

Options > Preferences ( #I8 > RIFELE ) - 2
EY Option (3218 ) THITTHAEZRAY Preferences
(RIFERTE ) & » A REfER - ERI{EM DDC/
Cl WIE BB Re L > ReeE A Help (F1A)
82 Options (3EIH ) 124 °

14

2-Phips 22581 (CS30715000001) () (X

PHILIPS

Preferences

FRERINRERTE °
AT SRR B L ThEE o AR I %
B o
TERR S On (FIRk) =M LA Enable
Context Menu ( BRFE ARINEES ) ° Enable
Context ( BRAARAR ) ThEEXREHERHMNA
BARTHEEZRH » BE7N Select Preset (42
EXFEE%/E ) A Tune Display ( f{FA#E 2% )
By SmartControl Lite 32218 o Disable ( {8 )
SBBRARARINEEFR Y SmartControl
Lite ©
FEE 232 On (BIRR) Enable Context (R
BAIERE) - BUBARIhBER AT Smart
Control Lite W TfEEINAER - FELIFE
BRLE—TERAR - BIRJEER Help
(%8R ) ~ Technical Support (3T E ) ~
Check for Upgrade (# &8 H7) ~ About (B8
) A Exit (4551 ) STHAEFREE - =
Enable task tray ( BtFE LE[E ) ThEEsRES -
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Options Presets

.

Help

Analog In Digial In
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7\5{55)?%&?1: °
. — AR AZERILER -

Options >Audio (EI& > Hifl) -
(IR ) THIIHAER PRI Audio (
ZReER -

#ZEY Options
Ha) &

TERI{E A DDC/Cl FEZ 2R n_—\%%J: g
£ F3 Help (5%HA ) B2 Options (2818 ) 2% -
B smartcontrol 2 phips 22581 (CS30715000001) ()X
SmartControl Lite PHILIPS
=]
Adjust Audio
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=
Options Presets
\ S5 Muki Monitor
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User Manual

Adjust

s
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Color 5
Display D

User Manual Tech. Support
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Context Sensitive menu ( A& FEREE ) THEE
Context Sensitive ( AA1EEE ) THRER TR Z K
F8 o #7£ Options > Preferences (3218 > {R4Y
HTE ) PA)IETY Enable Context Menu ( BB A
RINEESR ) BIARZERIEINAER -

@ SmartControl
Helect Preset
Tune Display

L4

Context Menu ( IRThEESR ) BILEER :
SmartControl Lite - #2EX th18 B B2 28R
About (EBFA) EBM °

Select Preset (ZERTERL(E ) - AJIRMHLREE
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Tune Display ( fHFAZE %Y ) - AFHIRR
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E{F Task Tray ( T1E[E ) ThAE {2 Task Tray ( T1E[E ) ThAE
1% Task Tray ( TE[E ) 9AY SmartControl Lite  {Z R R EERIRHHY Task Tray ( TIEME )

BRLEZ—TBEA% - BB Task Tray B> QBB EXIT (#53R) ZEIUE - B
(ITfFE ) Thaek - H— FARASREER BILFEETEBER SmartControl Lite » 551
B Options > Preferences ( #18 > {RIFERE )

2 Run at Startup ( BIMRFEAT ) ©

Help

Technical Support
Check for Update
About

Exk

Iﬂﬂ:ﬁﬁ@gg
Help (5788 ) - AJ#ZEX User Manual ( {8
FM) BER - ERERNIBERRERRK
User Manual ( EFASF ) #E% -
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+  Check for Update (@B E %7 ) - A& F
EHEA PDI BiERE - WigEFERENNR
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EEHXBAT SmartControl Lite » 3R] LU
Program (123X ) ThEEZREEY SmartControl
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SmartControl

SmanControl

20
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Copyright 1993-2007 Portra Dispiaye, Inc.
Patents Pending

17



4. FAlaRRAg

273E3QH

EH BT

LCD miRER AMVA LCD

5 WLED

HRR S 27" ( 68.6 cm)
REL 16:9

BEREBE 0.31 x 0.31 AEE
=E 300 cd/ FERAD
SmartContrast 20,000,000:1
HHE (—#%) 5000:1

[ElFERFRE (HA) 12 27
SmartResponse ( 217 ) 6 =

1aR

RERITE 1920x1080 @ 60Hz

HA 178° (H) / 178°(V)@C/R>10

EEIEARINEE Smartlmage Lite

BREX 167 M

FHBHIAEX 56Hz -71Hz

IKFEHEE 30kHz - 83kHz

sRGB =

(BN DVI-D (&fir) ~ VGA (FLb) ~ HDMI

B /B PC Fa@mA - B

N ERIRZ ~ sxBRT

BRERME v ©/a O 1]/« /0K

OSDh Z= T~ RN B s FJAF ~ 3 AT
MR  EEFX  TEEX

Hi@EFThaE Kensington Bfj 2584

FEREN A DDC/CI ~ sRGB » Windows 7 » Mac OSX ~ Linux

-5/+20
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273E3QH

FFR B 355W (—#%)
BW (wK)
HFEE 683 100VAC B 115VAC 83 230VAC
( EnergyStar 5.0 A 57% ) +/-5VAC 78 +/-5VAC ZZ7u#h +/-5VAC 335786
NERRA 50Hz | ASEEFA 50Hz | AEERRA 50Hz
+/- 5Hz +/- 5Hz +/- 5Hz
ERRE (—) 25.4W 25.5W 25.6W.
fERR (f5m 0.5W 0.5W 0.5W
EalEi] 0.3W 0.3W 0.3W
B * 65 100VAC A 115VAC f6F3 230VAC
+-SVAC 2578 | +/-5VAC X7 +/-5VAC 2256
BRR 2 50Hz BERFA S0Hz | ABEREFA 50Hz
+/- 5Hz +/- S5Hz +/- 5Hz
IEBBRE 86.69BTU/hr 87.03BTU/hr 87.37BTU/hr
fERR (5 1.71BTU/hr 1.71BTU/hr 1.71BTU/hr
EalES] 1.02BTU/hr 1.02BTU/hr 1.02BTU/hr
BIR LED 15 E THELEXN B THe./ TEREX A6 (BE)
EEtpERR JZEN 5 100-240VAC » 50-60Hz
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EmEE (WxHXD)

642x440x227 /NEE

EmAER (WxHXD)

642x391x64 NEE

BERFN (Exmxik)

700x525x138 /AEE

mEEE (BER)

Emaxg 8.2kg
EmAaxy 6.5kg
EmaBEMH 8.82kg

0°C % 40°C

mEHE (GERED)

-20°C 2 60°C

HERE

20% £l 80%

BE

BIEP 1+ 12,000 ZEIR (3,658 AR)

JEIBMER 1 4 40,000 ZEOR (12,192 AR)

MTBF ( Sk = B )

ROHS (BT EXRXETEY
BIRAES

30,000 /)\Bsf

=
=

ERIRE

EPEAT SRIZFREE (www.epeat.net)
BEMR 100% A [E]H
SNEWNE Sh5R 100% A PVC/BFR ( NEFEEAR K it EREs )

CE Mark ~ FCC Class B ~ SEMKO ~ TUV/
GS ~ TUV Ergo ~ UL/cUL ~ Energy star 5.0 ~ TCO certified

B ]
RE O | BOB
e
1. EPEAT $4SV4R4S(E1T Philips ST E RINFTIEHE R - BEIFTIEHAIETIRES - 5i8sh

www.epeat.net °

2. RIBERNBEE)  BRABITEH ° 552 www.philips.com/support NE{ERHTARAL &



41 BT ERTRRRC
0 sKEE

273E3QH
1920 x 1080@60 Hz (ELL#EA )
1920 x 1080@60 Hz ( Eifirsg A )

B ZEEE

273E3QH
1920 x 1080@60 Hz ( E{freg A )

3147 720x400 70.09
3147 640x480 59.94
35.00 640x480 66.67
37.88 800x600 60.32
48.36 1024x768 60.00
63.89 1280x1024 60.02
55.94 1440x900 59.89
65.29 1680x1050 59.95
67.50 1920x1080 60.00




TBREE

51 BEEE
W RIBHIE ISR EEFFA VESA DPM FRETHY
?E/T%ﬁkﬁ‘; RS AR R EER

DIBE - AREATIRE  BESEME
N EE’]E@J\EM’F CBTRIEEE "R
BE, - PRERHIEAEEEHENFEEE
FRTSE -

273E30QH
VESA &= | B |AKFR| EE EASER LED 5%
¥ | RE
BB | BR | B B 358W (—H&) BHE
4SW (FK)
izl BR | 8%F | %F 05W B
() (Pa)
il kil 03W kil
Y=yl $$§Ea—%§ﬁ$ SERFEAEE °

FEIAEEMTE 1920 x 1080
LR 1 50%

S 1300 nits

&R 6500k (fEA2EE)

S i
RIEERINE#E)  DARBITEA -
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6. ;AN

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance
with European community’s stringent RoHs
directive mandating restrictions on hazardous
substances in electrical and electronic equipment
have been adhered to in order to make Philips
monitors safe to use throughout its life cycle.

Congratulations!
This display is designed for both you and the

planet!
to some of the strictest quality and
environmental requirements in

the world. This makes for a high performance

product, designed with the user in focus that also

minimizes the impact on the climate and our

natural environment.

The display you have just purchased
carries the TCO Certified label. This
ensures that your display is designed,
manufactured and tested according

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering

*  Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions as low
as normal household background levels

* Low acoustic noise emissions (when
applicable)

Some of the Environmental features of the TCO
Certified for displays:

*  The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

*  Very low energy consumption both in on-
and standby mode minimize climate impact

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury and
lead (RoHS compliance)

*  Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and IT-manufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

TCOFF1058 TCO Document,Ver. 2.1

Tm

CERTIFIED

Technology for you and the planet


http://www.tcodevelopment.com

EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors
based on 51 environmental criteria
developed through an extensive stakeholder
consensus process supported by US EPA.
EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”
Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

~

5
e

6

CE Declaration of Conformity

This product is in conformity with the following

standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment)

* EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)

e EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment)

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission)

* EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable

e 2006/95/EC (Low Voltage Directive)

*  2004/108/EC (EMC Directive)

*  2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive for
Standby and Off mode power consumption)
and is produced by a manufacturing
organization on ISO9000 level.

* The product also comply with the following
standards

e 1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

» GS EK1-2000:2009 (GS mark requirement)

e prEN50279:1998 (Low Frequency Electric
and Magnetic fields forVisual Display)

e MPR-II (MPR1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

e TCO Displays 5.0 (Requirement for
Environment Labeling of Ergonomics,

Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions

Energy Star Declaration
(Wwww.energystar.gov)

As an ENERGY STAR® Partner;

.l we have determined that this
product meets the ENERGY STAR®

guidelines for energy efficiency.

& Note

We recommend you switch off the monitor
when it is not in use for a long time.
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Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to
provide reasonable protection against
harmful interference in a residential
installation. This equipment generates, uses
and can radiate radio frequency energy and,
if not installed and used in accordance with
the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the user
is encouraged to try to correct the
interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

*  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

e Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

25

FCC Declaration of Conformity
Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.



Commission Federale de la Communication
(FCC Declaration)

€ Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces limites
sont congues de fagcon a fourir une
protection raisonnable contre les
interférences nuisibles dans le cadre
d'une installation résidentielle.
CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si l'appareil
n'est pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
Cependant, rien ne peut garantir 'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est la
cause d'interférences nuisibles pour la
réception des signaux de radio ou de

télévision, ce qui peut étre décelé en fermant

I'équipement, puis en le remettant en
fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement et

le récepteun.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

*  Demander |'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
|'approbation des services compétents en
matiere de conformité est susceptible
d'interdire a |'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour les
connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spacf-
cally stated that it iz 8 Class A device on the specification labsl. The following appliss to
devicas in Class A of EN 55022 (radius of profection up to 30 metars). The user of tha
davica is obliged to tske all stape necessary to remove sources of intarferance to tele-
communication or other devicas.

Pokud neni na typowsm Stithu i
spadi automaticky do tfidy B podie EN 55022, Pro zafizen! zafazend do Hidy A (chranné
pésmo 30m) podle EN 55022 platl nésledujicl. Dojde-li k rulanl talekomunikatnich nebo
Jinjich zafizeni je u3ivatal povinnen provést takovd opatfgnl, aby neSeni odstranil,

uvadeno, 26 spadé do do ffidy A podie EN 55022,




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer; and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacfi

Uszadzenie poieno by sasilane 2 gnazds 2 preylacaunym obuoden ochroniyin §..w.h 2
ks i

v 3 achrang
nts 16A (amperinty

icakg kabla

by Batwo dostgpine.

Fplececising

wpychié adh edmiotine do atwondvw systern ke

e, poprre ewarcie clemes

puleroy pawini
lakawad atwosdw s
mimsaceais kXD iasyen o ez Eaatiwai) ay LA P
.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILFORSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)

| razEEnER2RE |




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schdden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerétes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Stérstrahlern nach Anlage Ill & 5
Abs. 4 der Rontgenverordnung erfiillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine

bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhohte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

) |ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT

ZUGANGLICH SIND,

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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HEPEAR (RFESTRSREREENE) (B PEKRRHS) -
PAFRISSIH T AP @Al R SN EEEEVRS T RN SRS B

ERERZFG
B (MAKCRT)
AHAENRSTE
BREEE R HEAEVRATE
# 3 i b EREE | SR_EM
(Po) | (Ho) | (Cd) | (CrB+) (PE3) (PBDE)
M s) [] [¢] [0) [e] [e)
CRIETH x [¢] [¢] [0) (@] [e)
| RS TE/ITE X [¢] ] [0) [¢] [e}
| iR a¥ x [0] ] [0) [e] [e)
| RRER x [¢] [¢] o) [¢] [e}
T/ X [¢] 8] 6] [¢] 6]
* FBEALAF B IR EDR R R R B meeaa B ke ERES
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RIBPEAR (RENERAEENE) FETHFAUTER -
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7. B P HRF5EA{RE

AT ERE TSR ERERARE

RAVER NN M RBENER - ZATE
RRITRRSCENRIER - BITRIEAIM
EEE - B BRFHERERSRN TR
LCD ER - BEHRERNTHRIEERNIE
C IERETREENRR  RBEAK
%ﬁ%?ﬁ%ﬁﬁﬁﬁ’ﬂ%gﬁﬁ%?@ﬂ * FRAUE
ﬁﬂ{%ﬁﬁﬁﬁﬁj—%ﬁ AR AR AVR R
» SIS EIER R TRVAEE SRR - Itk
/E%DH SARREENGRER - LULARE
B-REAIEIAERKE - &Y FEER
TRMEE SRR TFT LCD mR ERERRE
RE - WRBIBELAIEREKE - fln 1 5
BRI T EREARE] 0.0004% » BIRTRERE IR
Wim o A ARELEERERERSES
PEEMES| NER - RANEASH L EEREE
EEmERE - ARERIEA -

71

MR HMER MEER

[LE3

BEMIEER

—E&xE (NBEETER) A=EBENALA
EXACHMIMERM - FZEEE—EN
B—EE& - GRPHAEDERD2ERR
o —EwEENIMEE—EL—Ea R
RHIR - 2EEIFR > —ETEENIMEER
—BLU—EERBERHIR - HAENHED
BRAGRILIEMECNERGRHE -

BRIZRTERR
BEMDEREREER FLIRRFZ IR -

EMERRES  8—HNELEIREE
7

SoELIRE

SRR RIA R S E SN THR L MERESR
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BE BRI SARBER TBE  WEER .
FHRE - RS BREERRERSE

BIE - @EEL RN TEE - Y TR2E
B TE AR -

RRGERER
BRI FRE RN DB RIZRES
I NEE  RATBRGEREZRERERIA
TR -

GRERETRE

Philips FEI#EZ~2RAY TFT LCD MR @ WERA
BB TRPTIIRFRBNERETERR - 7
FearREHEBENGRERATENEEE
BT -

SEhZ EREL nERHNEE

1 (EREzEIEE 3

2 [E#SERACRIEE 1

3 EFERBvEBEERE (1 EEeExR) 0

R {E SRR i R B * >15 NEE

FrEfA v SRR AR S 3
EE .

IREESEIEES 5 IR

2 [E#f e REIEIE 2 IR

3 (@ ZRlEE 0

PR {E SR B R A 2 BE B * >15 NEE

FrE R B R S 5 IR

i QUERAT AERNEE

BRIz s R BRB AR 5 IR
6 i

1.1 2% 2 [ERFERIBRREE =1 B3 RE
2. AFRRERTIR 15O 9241-307 fREL o (15O 9241-307 : FABFRETSHMARTLERTE @ 8
BT RFAMERIHATTIE)
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72 BFRFERE

MHEREBEEMN NSV EMSIET

INAI B FT NHIE SRR
AR R RS AN -
R e
Germany Siemens &S

Z =
2K

ERERR
+49 01803 386 853

F84ash www.philips.com/support BEAEEA
B E AN Philips EEE‘:F‘/U%”\D

1Bt
€0.09

&l » &

United Kingdom

Invec Scotland

+44 0207 949 0069

Local call tariff

Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 € 0.07
Belgium E Care +32 078 250851 €0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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http://www.philips.com/support website

FR R R SR B [ A BHE B AT -

S BRAD  ASC ERER
BELARUS NA IBA +375 17 217 3386
BULGARIA NA LAN Service +359 2 960 2360
CROATIA NA Renoprom +385 1 333 0974
ESTONIA NA FUJITSU +372 6519900
LATVIA NA “ServiceNet LV" Ltd. +371 7460399
LITHUANIA NA UAB "Servicenet" +370 7400088
ROMANIA NA Blue Ridge Intl. +40 21 2101969
S R |NA Kim Tec doo. +381 11 20 70 684
SLOVENIA NA PC H.and +386 1 530 08 24
UIEINE NA Comel +380 562320045
NA Topaz-Service Company | +38 044 245 73 31
. NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

T MR EHE A -

BB BRHBO BRER
Brazil 0800-7254101
: Vermont

Argentina 0800 3330 856
FRERHR &N -

oy
ZAREF#R : 4008 800 008
JEEIMNEHREET -

E7ES BRHPD ASC BTRER
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696




TR~ RRBEIEMNHREHEE -

BIZ BRAD ASC BRER
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | . -\ Tel. (853)-0800-987
. Tel:1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56477
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA ’SE'S Computer System Co. | 451 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
UNITED ARAB AL SHAHD COMPUTER
EMIRATES NA LLC 00971 4 2276525
Israel NA Eastronics LTD 1-800-567000
, , +84 8 38248007 Ho Chi Minh City
Vietnam NA FCPT Se”'cft('j”‘cormat'c +84 5113.562666 Danang City
S S +84 5113.562666 Can tho Province
- , (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 10 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
s Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977.1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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